
1. Checking Functions 

2. How Does my PC Programming Light Work?

■ Run the demo program. 

■ Let's think about what type of sensors are used in home appliances around you.

The main body is pre-set with a demo program.
Correctly insert three AA size batteries in the battery 
holder and turn the switch on. Verify that the LED on 
the main body illuminates in order of red, green and 
blue for 1 second each. 
     
If the demo program does not run, check if you've 
soldered the parts correctly. Also make sure the 
batteries are inserted in the correct polarity.

I ran the demo 
program! □

Checkpoint!

I understand how my PC 
Programming Light works. □

←PC

Checkpoint!
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What kind of sensors? In what appliances? How are they used?

Computer

Light sensor

Sound sensor

Reflective 
infrared sensor

Communication

Sound sensor

Reflective 
infrared sensor Light sensor

Input Output 

Light 
(seven colors)

【Processing】Light 

Sound

Infrared 

USBCommunication
Interface

Full-color 
LED

★ Product #153179 (Circuit Board Assembly 
Required) only has light sensors.(　　　　　)
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3. Let's Use the Programming LED Light Software!
■ Installing the Programming LED Light software from a CD-ROM
Insert the CD-ROM into your computer's CD/DVD drive. Access the CD/DVD drive from My Computer, 
then drag and drop the "Programmable LED Light" icon onto the desktop.

■ Installing the Programming LED Light software from our homepage

■ Double-click the "Programmable LED Light" icon to launch the software.

Go to our website (http://www.artec-kk.co.jp/en/pll) and download "Programming LED Light 
Software" to your desktop.

■ Connect to Your PC to Check Software

■ Making a Program
Place LED Icons in the Light Color row to set the colors you want to use.
In the Time row you can set the duration of the flash from 0.5 to 9.5 seconds.
If you want your program to loop, drag a Repeat Start icon into a box of the Repeat/Order row.

Now let's make a program! When you drag an LED Color icon into the first row it's duration will automatically 
be set as 0.5 seconds. 

My PC recognizes 
the unit. □

Checkpoint!

I've placed icons in the 
Program Area. □

Checkpoint!

Screen Overview
The picture to the right shows the screen 
where you make your program.
To create a program, drag and drop LED 
Color and Repeat icons into the Program Area.
Up to 24 icons can be placed.
The icons you chose will run in order, 
starting with number 1. 
Data is transferred to the main unit of your 
Programmable LED Light when you click the 
Transfer button.
You can use Light, Sound, and Reflective Infrared 
 Sensor settings to incorporate them into your 
program. Click the Monitor Display button to 
view and print out the text of your program.

LED color 
icons

Sound sensor 
settings

Data transfer 
button

Display text

Infrared sensor 
settings

Light sensor 
settings

Program 
control

Loop icons

PC Programming Light

Connect your PC Programming Light unit to your PC's USB 
port. Check to see if a yellow icon appears on the bottom left 
of your software screen. Seeing the message "Connect the 
main body to your PC" means your PC Programming Light 
hasn't been detected. Be sure to check the following:

Is your device driver properly installed?
The first time you connect your board it make take 
some time for your PC to detect it. Check the Assembly 
Instructions for details about installing your USB device 
driver.
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■ Editing Icons 
Right-click on the icon you want to change to bring up the Edit menu.

■ Transferring and Running Programs

■ Powering the PC Programming Light 
When using battery power, turn your unit ON to start your program.
Your unit is powered automatically when connected to a PC, even when the 
switch is set to OFF.
Connecting the unit to your PC when the Control Software is already running 
will stop the program running on your unit as it waits for input from the software.

Delete
(Removes an icon.)

(Removes a column, pulling 
the remaining ones to the left.)

Delete a Column 

Add a Column
(Inserts a new column in 
between two existing ones.)

■ Useful Features

 "File" > "Open":
Open data you've saved.

"File"  > "Save As":
Save any programs you've created.

"Edit" > "Reset":a
Deletes all previously set icons and data.

I now know about 
useful features. □

Checkpoint!
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ON

①
②

③ ④

You'll need to transfer your finished program 
from the Programming LED Light software to 
the unit. 

Clicking Transfer will transfer your program to the 
unit.  Click Exit when the transfer completes.

Select Start from the Run menu and the program will 
run.
(You can also press F5 on your keyboard to run the program.)

Select Stop from the Run menu to stop the program.
(You can also press F6 on your 
keyboard to stop the program.)

If you see the message "Connect the 
main body to your PC," check to see 
whether the USB device driver has 
been properly installed.
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edit icons. □

Checkpoint!



4.  Programming Sequences

■ Sequential Program 1
Make a program that flashes your LED red for 1 second!

I ran sequential 
program 2! □

Checkpoint!

I ran sequential 
program 1! □

Checkpoint!

I ran sequential 
program 3! □

Checkpoint!

■ Sequential Program 2
Now make the LED flash red, green, blue, yellow, light blue, purple, and white for 1 second each! 

■ Sequential Program 3
Now set any colors in any order you want to flash for any amount of time!

■ Tip
Ex: You can program the LED Light software like the demo program below.  

(1) Drag and drop the red LED icon into space 1.

(2) Set the number under the red LED icon to 1.0 sec.

(3) Drag and drop the green LED icon into space 2. 

(4) Set the number under the green LED icon to 1.0 sec.

(5) Drag and drop the blue LED icon to space 3.

(6) Set the number under the blue LED icon to 1.0 sec.

① ③ ⑤

② ④ ⑥

⑧

⑦

⑦

(7) Click the Transfer button to transfer your program to 

the unit. Once the program has transferred, click Exit.

(8) Select Start from the Run menu and your program will 

run. 
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5. Programming Repeats

I ran looping program 2! 
　　　　　　□

Checkpoint!

I ran looping program 1!
　　　　　　□

Checkpoint!

■ Looping Program 1 
Without using the Repeat icons, program your LED to flash yellow, light blue, purple, yellow, 
light blue, purple, yellow, light blue, purple, yellow, light blue and purple. 

⑦

⑥

①

② ③

④
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■ Checkpoint!
You can use Repeat Icons to loop some or all of the LED Icons you've placed in your program.
Example:
(1) Drag and drop a red LED icon into space 1.
     Drag and drop a yellow LED icon into space 2, green 
     into space 3, light blue into space 4, and blue into 
     space 5.

(2) 　　　 Drag and drop a Repeat Start icon into the 
                    2nd space of the Repeat/Order row. 

(3) 　　　Drag the 01 Times Repeat icon to the 4th 
                   space in the Repeat/Order row and drop it.

(4) Double click the 01 Times Repeat icon to bring up a 
      settings window.

(5) Use the arrows to set the number of repeats to 3.
(6) Click Transfer to transfer your program.

(7) Select Start from the Run menu and your program will 
      run.

　 The demo program will run in this order: 
      "1→2→3→4→2→3→4→2→3→4→5"

　 Choosing Continuous in the Cycle Setting window will make the selected section loop 
     forever.

■ Looping Program 2
Using the Repeat icons, program your LED to flash a sequence of yellow, light blue and 
purple four times!

Double click
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6. Using Sensors Program

■ A Light Sensor Program
Now make a program that makes the LED flash white if you cover the Light Sensor with your hand.
Try adjusting the sensor threshold and see how it changes!

I ran the Light Sensor 
Program!  □

Checkpoint!

I ran the Sound Sensor 
program! □

Checkpoint!■ A Sound Sensor Program
Make a program that lights up an LED when you speak into 
the Sound Sensor (mic).
Try adjusting the sensor threshold and see how it changes!
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■ How to Use Light Sensors
① Drag a Brighter or Darker icon into 
    the Sensor box of Condition 1.
　 This will automatically place the 
    opposite icon in the Sensor box of 
    Condition 2.

② Drag a Flash or Lights Off icon 
    into the LED Response box of 
    Condition 1. This will 
    automatically place the opposite 
    icon in the LED Response box of Condition 2.
    Set the threshold of the icons by dragging the Threshold slider. The higher the value, the brighter the 
    light will need to be for your program to respond. Remove icons from Condition boxes by right clicking 
    the icon and choosing Delete. The picture above shows a program that will start in response to any 
    brightness level higher than 0.

■ How to Use Sound Sensors 
You'll need to select Display from the Menu bar and click 
Sensor Control B in order to use your Sound Sensor.
Click the ON button for the Sound Sensor and your program 
will now use it. Set the threshold of the icons by dragging the 
Threshold slider. The higher the value, the louder the sound 
will need to be for your program to respond. For example, a 
program that responds to small sounds will need a threshold 
value of -5. The picture to the right shows a program that will 
start in response to 
any sound higher 
than +2.

You can program the signals that react to light and sound from the 3 sensors on the PC Programming Light 
body. Transferring your program to the main body and clicking Start under the Run menu will cause your 
sensors to go into standby mode.  Your program will run once the sensor response conditions you've set have 
been met. Signals from sensors will be disabled while the program is running. The sensors will return to 
standby mode once your program has finished running. If you have made settings for multiple sensors, your 
program will start when the response conditions for any one of those sensors have been met.

①

①

②

②

Worksheet  Worksheet  PC Programming Light



7. Get Creative!

■ A Reflective Infrared Sensor Program

■ Apply Your Knowledge and Make Your Own Program!

Make a program which starts when you cover the 
Reflective Infrared Sensor with your hand.

Monitor Display: Click this button to display the text for any program you've made.
You can also enter your name, grade, class and your impressions and print them out! 

I ran the Reflective Infrared 
Sensor program! □

Checkpoint!

I've customized 
my light! □

Checkpoint! 

Checkpoint! 
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■ How to Use Reflective Infrared Sensors 

8. Customize It!
■ Make your light your own 
     using Artec Blocks  !

I made and ran my 
own program! □

R

You'll need to select Display from the Menu bar and 
click Sensor Control C in order to use your Reflective 
Infrared Sensor. Click the ON button for the Infrared 
Sensor and your program will now use it. As your 
Reflective Infrared Sensor only detects changes in 
heat, there is no threshold that needs to be adjusted. 
The picture below shows a program which starts 
once your Reflective 
Infrared Sensor has 
detected a change in 
heat.
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9. Summarize It!
(1) What roles do the software, sensors, and computer have in your programming? What else did 
      you learn?

(2) What was easy about making a program? What was hard? How did you solve the problems you
     encountered?

(3) Aside from LEDs, what else would you like to use the Light, Sound, and Reflective Infrared 
     Sensors of your PC Programming Light to control?

(4) How can programming be used to improve our lives?

(5) How do you think programming will be used in the future?
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